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Introduction

Because of the large amount of time it can take to schedule appointments, work
with email, manage your contacts, and the like, being able to collaborate with your
coworkers and colleagues easier can save you time and greatly increase your
productivity. MDaemon® GroupWare Plugin for Microsoft Outlook can help you
accomplish that goal.

MDaemon® GroupWare Plugin for Microsoft Outlook makes it possible for you to
share your calendars, contacts, and other Microsoft Outlook items with other
MDaemon GroupWare users. The GroupWare plugin provides Outlook item sharing
by enabling Microsoft Outlook to use special IMAP folders located on your MDaemon
GroupWare enabled server. These folders can be configured to store whatever type
of Outlook items that you designate: calendars, contacts, notes, tasks, and so on.
Further, for each of these folders you can grant multiple levels of access permission
to other MDaemon GroupWare users. For example, to one user you might wish to
grant permission to read one of your calendars but not add items to it, but to
another you might wish to grant complete access that is equivalent to your own.
When you grant an MDaemon GroupWare user permission to see one of your folders
it will appear in his or her Outlook Folder List, and the folders to which you have
been granted access will appear in yours.

Thus the MDaemon® GroupWare Plugin for Microsoft Outlook can help you to
improve your efficiency by allowing you to share your Outlook items and collaborate
with your colleagues directly using the productivity features built in to Outlook.

Requirements

MDaemon® GroupWare Plugin for Microsoft Outlook requires Microsoft Windows 9x
or later, and Microsoft Outlook 98 or later must be installed on your system.
Further, an Internet or other network connection is required in order to connect to
the MDaemon mail server that is hosting your mail services, and that server must
be MDaemon GroupWare enabled. Finally, permission to use MDaemon GroupWare
must be enabled for your specific MDaemon user account—only GroupWare enabled
accounts residing on the same mail server can share Outlook items via GroupWare.

Installation

MDaemon® GroupWare Plugin for Microsoft Outlook is available as a stand-alone
installer that can be downloaded from WorldClient, MDaemon’s web-based email
client. If you do not have access to WorldClient then contact your supervisor or
email administrator to obtain the plugin by some other means, such as on a floppy
disk or via an alternate download location.

MDaemon GroupWare 4 Installation
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Downloading the MDaemon GroupWare Plugin

To download MDaemon® GroupWare Plugin for Microsoft Outlook from within
WorldClient:

1. Open your web browser to WorldClient’s sign-in page. In most cases, the
address of the sign-in page is something like, “http://www.example.com” or
“http://worldclient.example.com:3000.”

2. Type your email address and password in the spaces provided, and click
Sign In to sign in to your WorldClient account.

3. Click Options (or click the Options button if the WorldClient theme you are
using has buttons instead of text links).

4. Click GroupWare.
Click Download the MDaemon GroupWare Plugin for Outlook.

Download outlookPluginInstall.exe taking note of the folder to which you
save it.

arnMDaemon’

Groupware Plugin
Completetand Atfar ‘,th,ﬁji%@éﬂ]?i@;%ﬁ%_\ : ’i
& \
;l'.i'_e MDaemon Groupware Plug-in

Welcome To MDaemon GroupWare!

Thiz installer will update your Microzoft Dutlook. installation so that it can share
information with other MDaemon Groupw are uzers.

/)

repre . It iz strongly recommended that you exit all windows programs before running this
i Setup Program.
Copr Click Cancel to quit Setup and close any programs you have mnning.  Click Mext to

continue with the Setup program.

MDaemon Groupih's

wWARMING: This program is pratected by copyright law and intermational treaties.
o Share folders, .

o0 Enable MDasmaol Unauthorized reproduction or diztribution of thiz program, or any portion af it, may
0 Enable Outlook | rezult in severe civil and criminal penalties, and will be progecuted to the maximum
o0 Save money by extent passible under law.

See RELMOTES. TXT

Installing the MDaemon GroupWare Plugin
To install MDaemon® GroupWare Plugin for Microsoft Outlook:

1. Close Microsoft Outlook if it is running. It is also recommended that you exit
all other Windows applications that you may have running before continuing
with the installation.

2. Click Start, and then click Run... on the Windows start menu.

In Open, type the path to outlookPluginInstall.exe, or click Browse... to
locate it.
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Click OK.
Click Next.

6. Read the License Agreement and then click I Agree to continue with the
installation.

Click Next.
Click Finish.

Configuring the MDaemon GroupWare
Plugin for Microsoft Outiook

Using the MDaemon GroupWare Wizard

The first time you launch Microsoft Outlook after installing the MDaemon®
GroupWare Plugin, the MDaemon GroupWare Wizard will be displayed. Use this
wizard to create your MDaemon GroupWare mailbox within Outlook. Before
continuing with the wizard, however, there are a few things you will need to know:
the host name of your MDaemon GroupWare enabled mail server (usually
something like mail.example.com), your login name (usually your email address),
and your password. When you are prepared to continue with the MDaemon
GroupWare wizard:

1. Read the first screen and click Next.

MDaemon GroupWare Wizard

q alt-n MDaemon Flease specify an MDaemon server pou will uze to share Dutlook items:
Groupware Edition

MDaemon GroupWare

Yersion 1.0.0h Hosthame: |mail.example.net
: =
Copyright 2003 AN Technalogies, Lid IRaE =

All Rights Reserved.
http: /Ay, altn. com

Login: IDwimbIe@exampIe.net

Password: I *******

¥ Remember password

Ping Server |

Previous | et > I Cancel |

2. Enter the Hostname of the GroupWare enabled mail server hosting your
account.

3. Leave the Port set to the default value of 143 unless you have been
instructed by your email administrator to set it to an alternate value.

4. Enter the Login and Password of your GroupWare enabled MDaemon
account.

5. Click Remember Password if you want the GroupWare plugin to save your
password and thus log in to your account automatically in the future. Clear

Configuring the MDaemon GroupWare Plugin for Microsoft Outlook 6
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the check box if you wish to reenter your password each time you launch
Outlook.

6. Click Ping Server to test your settings. If you encounter any errors during
the test then contact your email administrator for help.

7. Click Next.

MDaemon GroupWare Wizard

q alt-n MDaemon ) Pleaze specify the PST [Personal Storage] file you will use to locally store shared
Groupware Edition Outlook items.

(" Create a new PST file
MDaemon GroupYvare
Yersion 1.0.0h * Use an existing PST file

Copyright 2003 AN Technologies, Ltd IR

All Rights Reserved.
http: /Ay, Sltr. com

Previous | Mest - I Cancel |

8. A PST (personal storage) file will be used for the shared Outlook items that
are stored locally. Click Create a new PST file if you wish to create a new
one, or, if you wish to use one that already exists, click Use an existing
PST file and then click the file that you wish to use. If you are not sure
which option to choose, see Choosing a Personal Storage File—page 8.

9. Click Next.
10. Click Finish.

Creating an MDaemon GroupWare Mailbox Manually

If you choose to bypass the MDaemon GroupWare Wizard, you can also create
MDaemon GroupWare Mailboxes manually within Outlook. To do so:

L Click GroupWare Mailboxes on the

GroupWare toolbar. If you do not see the
GroupWare toolbar then click
View->Toolbars>MDaemon GroupWare e ey
to activate it. Alternatively, you can also

reach the MDaemon GroupWare Mailboxes
screen on Outlook’s Options dialog
(Tools>Options>MDaemon
GroupWare).

2. Click Add.

A PST (personal storage) file will be used o |
for the shared Outlook items that are il |1V

The following MD aemon Grouptw'are mailboxes are installed:

Dielate | About |

Stored |Oca”y. C||Ck Create a hew PST file PST File: I.&pplication DatakDaemon Grouphafarei ailboxes\Mailboxd. pat

if you wish to create a new one. If you wish
to use a PST file that already exists, click o |

Cancel |
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Configuring the MDaemon GroupWare Plugin for Microsoft Outlook

10.

11.

12.

Use an existing PST file, click the file that you wish to use, and then Skip
to Step 6 below. If you are not sure which option to choose, see Choosing a

Personal Storage File—page 8.

Type a filename for your new PST file, or accept
the default one that is generated automatically.

Enter a name for your GroupWare mailbox. This
is the name that will be displayed in your
Outlook Folder List and is purely for your
reference—it will not be visible to other users.

Click OK.

Enter the Hostname of the GroupWare enabled
mail server hosting your account.

Leave the Port set to the default value of 143
unless you have been instructed by your email
administrator to set it to an alternate value.

Enter the Login and Password of your
GroupWare enabled MDaemon account.

Click Remember Password if you want the
GroupWare plugin to save your password and
thus log in to your account automatically in the
future. Clear the check box if you wish to
reenter your password each time you launch
Outlook.

Add new GroupWare Mailbox
% Create a new PST file

Location of the PST file where mailbox contents will be
shored:

Ion Grouph areMailboxesh G mailbox0l . pst |

The name of the mailbox az it will be displaved in
Clutlook:

|Dwimble's Groupty*are b ailbos

= Use an existing PST file

[ ates Al existing Erauptslane folders and items wil be
uplnaded b thesemern

(]9 I Cancel

Click Ping Server to test your settings. If you encounter any errors during
the test then contact your email administrator for help.

Click OK and OK.

Choosing a Personal Storage File

Your shared Outlook item data is stored on your GroupWare enabled mail server in
special IMAP folders. However, Outlook also synchronizes and stores this shared
data locally in personal storage (PST) files. Whether creating a GroupWare mailbox
manually or by using the MDaemon GroupWare Wizard, you must choose whether
to create a new PST file or use one that already exists. If you are not sure which
option to choose, here are some guidelines to help you decide:

If you do not already have an email account or GroupWare mailbox
configured within Outlook, choosing to create a new PST file is probably the
best option.

If you already have an existing IMAP email account configured within
Outlook, a new PST file may be best.

If you have an existing POP account in Outlook that is associated with an
existing PST file, then selecting the associated PST file may your best
choice.

Configuring the MDaemon GroupWare Plugin for Microsoft Outlook
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Sharing Outlook Items and Folders

e If an Outlook email account exists (whether POP or IMAP) and you are
already using some Outlook items (calendars, contacts, and so on), then

using the existing PST file may be your best option.

Sharing Outlook Items and Folders

Outlook’s Folder List and MDaemon GroupWare
The content of your Outlook Folder List depends on the types of email accounts that

you have configured within Outlook: POP or IMAP.

IMAP Accounts

IMAP email accounts are displayed as separate mailboxes
containing only your IMAP email folders. Folders containing
shared Outlook items cannot be displayed in this IMAP
account’s list. GroupWare Mailboxes will be displayed
separately even if they are associated with the same
account information as the IMAP account on your MDaemon
server. For example, if you have an IMAP account in
Outlook for frank@example.net then a mailbox will appear
for that account in the Outlook Folder List. It will contain an
Inbox and any other IMAP email folders that you have
created for it. It will not, however, contain any shared
Outlook item folders such as calendars, contacts, and the
like—even if you have created an MDaemon GroupWare
mailbox using the same frank@example.net login
information. The GroupWare mailbox will be displayed
separately in the Folder List, and will contain your shared
Outlook items. It may be associated with the folders under
Outlook Today, or with another list of folders entirely,
depending on which PST file it is associated with.

POP Accounts

Falder Lisk

EI@I Cwimbledexample. net

52 Inbox 1)

El@ Ferzonal Folders

------ % Calendar

-2 Contacts

J@ Ouatbo

----- 3 Public Folders -4It-N Calendar
----- 3 Public Folders -PubCalendar
----- §% Public Folders -PubContacts
{.ﬁ Public Folders -Pubournal

----- £12 Sent [tems

Typically a POP email account will have its email deposited into the Inbox or other
email folders located under Outlook Today in the Folder List. This list of folders can
be associated with a GroupWare Mailbox and thus contain both shared Outlook

items folders and email folders.

Creating Folders

You can create folders and subfolders in any mailbox listed in Outlook’s Folder List.
When you create a new folder you will designate the type of items that will be
associated with it: mail, calendars, contacts, tasks, notes, and so on. Your IMAP
account mailboxes, however, can only contain mail items (i.e. email folders)—they
cannot contain other Outlook items such as calendars and contacts. Folders for
those Outlook items can be created in your GroupWare Mailboxes. Thus your IMAP
email folders and shared Outlook items will always be listed in different sections of

the Folder List.

Sharing Outlook Items and Folders 9
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To create a new folder in the Outlook Folder List:

Create Hew Folder EE

1. In the Folder List, right-click the mailbox or

folder where you want the new folder to be tlame:

placed, and click New Folder. Alternatively, |Mr-f Shared Calendar
click File>New~>Folder from Outlook’s menu _

bar. Eolder contains:

Kl

ICaIenl:Iar Items

2. Type a Name for your folder.
. Select where ko place the Folder;
In Folder Contains, choose the type of Outlook

item that the folder will contain: Calendar, E"@_E’?;‘;‘EEBIS ]
Contact, Journal, Task, Mail, and so on. IMAP - Cantacts
email mailboxes may only contain mail items. | | . (3 Deleted ltems
4. Choose the location where you want the folder = | . % ﬂf::
to be placed (if you didn’t already choose the 473 Joumal
location in step 1, or if you want to choosea | | i Motes
different location). &5 Dutbox
----- 2% Public Folders -At-N Calendar
5. ClickOK. i £8P iklie Faldars P kCalendar hd

(04 I Cancel |

Sharing Outlook Item Folders

You can use the MDaemon GroupWare Plugin to share your GroupWare Mailbox
folders with other MDaemon GroupWare users. You can designate which users will
be able to access them, and the level of access that will be permitted.

To share a non-mail Outlook item folder:
1. In the Folder List, click the folder that you wish to share, and then click

F_older_on the GroupWe_are toolbar. :Alternatively, MDaemon GroupWare Folder Dptions ]
right-click the folder, click Properties, and then —Syrichronize this folder
click MDaemon GroupWare Folder. & Eveny time | select this folder

2. Choose the main synchronization method that ™ Manually [click "Synchionize'" button)

you wish to use for the folder—how often
GroupWare will synchronize the local copy of the
folder with the copy residing on the mail server. [~ Synchronize this folder every L
You have three synchronization options: =

= Wwhen Outlook starts up and exits

i Permission
= Every time I select this folder—the local and Add Remove
server copies will be ;ynchronlzed every time hrankGonample ot
you select the folder in your Folder List. tisterbig@exarple et

DwimblefEexample. net

» Manually (click "Synchronize” button)—the
folders will be synchronized when you click

Synchronize on the GroupWare toolbar. [# Read items [ Folder visible
v &dd items [+ Create subfalders
»  When Outlook Starts and Exits—the folders [ Edititems I Administer

will be synchronized when you first launch v Delets items

Outlook, and when you close it.

3. If you want the folder to be synchronized at Last synehranized on SHHELIED S
regular intervals, click Synchronize this folder Synchronize now Mailbox Dptions |
every and then choose the desired number of
minutes.

Cancel |

4. In the Permissions section, click Add to specify a

Sharing Outlook Items and Folders 10 Sharing Outlook Item Folders
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user with which to share the folder.

5. Choose the desired user from the drop-down list box or type one in
manually. Depending on how your email administrator has configured your
mail server, the list box will contain one of the following: all GroupWare
enabled MDaemon accounts on your server regardless of domain, only
GroupWare enabled accounts that belong to the same domain as you, or no
addresses at all. If all of the addresses are hidden then you will have to
manually enter each GroupWare enabled email address that you wish to
share the folder with. Click OK.

6. Click the user in the permissions list and then click the boxes corresponding
to the access rights that you wish to grant:

= Read items—the user is permitted to see the contents of the shared
folder (i.e. see the calendars, contacts, and the like).

= Add items—new items can be posted to the shared folder.

= Edit items—Outlook items contained in the folder can be edited by the
user.

= Delete items— items contained in the folder can be deleted by the user.

= Folder visible— causes the shared folder to appear in the user’s Folder
List. If this option is not enabled then the user will not be able to see the
shared folder regardless of the other access rights given.

= Create subfolders— the user can create subfolders.

= Administer—the user has full permissions for the folder. He or she can
add, delete, and modify the folders and all items that they contain.

Click Synchronize now if you wish to synchronize this folder immediately.
Click Mailbox Options if you need to edit the GroupWare Mailbox’s settings.
Click OK.

Synchronizing Your Shared Folders

Shared Outlook items are created and edited on your local computer and then
synchronized with the copies that reside on the MDaemon GroupWare server.
Shared folders must be synchronized before others can see any changes that you
have made to the shared Outlook items, and before you can see any changes that
they have made. You can synchronize your shared folders manually, and you can
configure them to be synchronized automatically. You can also configure distinct
synchronization settings for each shared folder. Thus one folder could be set to
synchronize every 5 minutes while another could be set to synchronize only when
you manually click the Synchronize now button.

To configure the synchronization settings for a shared Outlook item folder:

1. In the Folder List, click the folder that you wish to synchronize, and then
click Folder on the GroupWare toolbar. Alternatively, right-click the folder,
click Properties, and then click MDaemon GroupWare Folder.

2. Choose the main synchronization method that you wish to use for the folder.
You have three synchronization options:

Sharing Outlook Items and Folders 11 Synchronizing Your Shared Folders
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= Every time I select this folder—the local and server copies will be
synchronized every time you select the folder in your Folder List.

= Manually (click "Synchronize” button)—the folders will be synchronized
when you click Synchronize on the GroupWare toolbar.

= When Outlook Starts and Exits—the folders will be synchronized when
you first launch Outlook, and when you close it.

3. If you want the folder to be synchronized at regular intervals, click
Synchronize this folder every and then choose the desired number of
minutes.

4. Make any necessary changes or additions to the permissions section.
Click Synchronize now if you wish to synchronize this folder immediately.
Click OK.

Help with Microsoft Outlook

For specific instructions on working with Outlook items such as calendars, contacts,
tasks, and so on, and for instructions on using Microsoft Outlook’s many other
features, see Outlook’s extensive help system and documentation.

Sharing Outlook Items and Folders 12 Help with Microsoft Outlook
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